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Info AGE Computer Services License Agreement

This is a legal agreement between the purchaser of this program and Info AGE Computer 
Services. If you do not agree with all of the terms of this Agreement then return the software and
all accompanying materials to:

Info AGE Computer Services
7760 McCallum Blvd.  #20205
Dallas, TX  75252

Word Database Software License

Registered Copy
1. Copyright.  The Software (Word Database) is owned by Info AGE Computer Services and is 
protected by United States copyright laws.  You must treat the software as any other copyrighted
material (e.g. a book or musical recording) with two exceptions: 1) you may make one copy of 
the Software solely for backup purposes, or 2) you may transfer the software to a single hard 
disk drive provided that you keep the original solely for backup purposes.  The written materials 
provided with the software may not be duplicated in any form.

2. License Agreement.  This Info AGE Computer Services License agreement (License) permits
you to use one copy of the Word Database software on any single computer, provided the 
Software is in use on only one computer at any one time.  To use multiple copies of the 
Software, you must have an equivalent number of Licenses.  the Software is considered "in use" 
when it is installed onto the hard disk drive of a computer.

Shareware Copy
If you have the shareware version of the Software, you may distribute it in the same condition as
you have received it.  This condition should be in the form of one single compressed file called 
IAWORDDB.ZIP, containing all of the relevant files, including the WDMANUAL.DOC, or the 
original un-compressed files SETUPWD.DOC, WDMANUAL.DOC, DATABASE.DOC, and 
LETTERWD.DOT.  However, you may not distribute the shareware version of the Software as 
individual files, contents of files as printed materials, or files with any modification.
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Warranty Information
Limited Warranty:  Info AGE Computer Services warrants that the Software will perform 
substantially in accordance with the accompanying written materials for a period of 30 days.

Satisfaction Guaranty:  If you are not satisfied with any part of the software within the first 30 
days of purchasing it, you may return it to Info AGE Computer Service for a refund of the 
Software price.  See the last section of this documentation for more information.

No Other Warranties:  Info AGE Computer Services disclaims all other warranties, either 
express or implied, including but not limited to implied warranties of merchantability and fitness
for a particular purpose, with respect to Software, and the accompanying written materials.

No Liability For Consequential Damages:  In no event shall Info AGE Computer Services or its 
distributors be liable for any damages whatsoever (including, without limitation, damages for 
loss of business profits, business interruption, loss of business information, or other pecuniary 
loss) arising out of the use of or inability to use this Software product, even if Info AGE 
Computer Services has been advised of the possibility of such damages.

This agreement is governed by the laws of the State of Texas.
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Prerequisites

Software/Hardware  Requirements
Microsoft Word for Windows version 2.0
Any computer capable of running Microsoft Word for Windows version 2.0

If Word is running from file server
Care must be taken if installing this Software on a shared Word program running on a local area 
network (LAN).  If everyone on the network wants to use the Software then the installation must
be performed on all workstations.  This will place the WORDDB.INI file in each persons 
WINWORD directory.

If the NORMAL.DOT template is shared among all of the users then the Software will be 
available to all users after the first installation process.

It is not recommended to share a single database file among network users since the file will be 
locked after the first person accesses the Software.  It is, however, possible to open the database 
file as Read-Only to use the database records, but not to update or change the contents.

Answer following questions before beginning installation:
1. What floppy drive are you installing from (A:\ or B:\)?

2. Where is your NORMAL.DOT template file located (most likely in C:\WINWORD\)?

3. Where would you like to place the database file (Example: C:\WINWORD\FILES\)?

Warnings
1. Before attempting installation, you must know the exact location of the NORMAL.DOT file.

This file holds the global macros and is required for running Word Database.  Unless this file
has been moved, you will find it in the WINWORD directory.  File Manager is a good tool 
for finding this file.

2. If you have a global macro by the name of "WordDB" then you must re-name it before 
installing the software.  Failure to rename an existing macro with stated name will result in 
the loss of the existing macro.  To see the list of global macros use the Tools/Macro menu 
options in Word.



3. If you have a file with the name of "DATABASE.WDB" located in the same directory that 
you would like to place the database file, you must move or rename the old file with stated 
name.  Failure to rename or move an existing file with stated name will result in the loss of 
the existing file.  This situation applies if you are re-installing Word database and you have 
an existing DATABASE.WDB file with records in it.  Failure to rename your old database 
file will result in the loss of all records contained in it.  The installation process will warn 
you before overwriting existing files, but you should not rely on this feature, please take 
precautions before installation.

4. If you have a template file with the name of "LETTERDB.DOT" located in your 
WINWORD directory, you must move or rename the old template file with stated name.  
Failure to rename or move a template file with stated name will result in the loss of the 
existing template file.  This situation applies if you are re-installing Word database and you 
have an existing LETTERDB.DOT that you have modified to fit your needs.  Failure to 
rename your old template file will result in the loss of the old template.  The installation 
process will warn you before overwriting existing files, but you should not rely on this 
feature, please take precautions before installation.

5. Never exit or stop the Word Database program by double clicking on the control box (top 
left-hand corner of window) or by choosing Close from the control box menu.  For faster 
operation, Word Database freezes the screen of Word and if you exit improperly the screen 
will not be released.

6. While using the Word Database, the background screen will be "frozen" to speed up the 
process.  It is possible that an unexpected error or action will interrupt the program without 
"un-freezing" the screen.  While the screen is frozen, the menus are still operational.  Save 
all of your files using the menu and then exit the Word program.  After exiting Word you 
can re-start it and continue your work.





Installation

1. Carefully read the Prerequisites section, including all of the warnings.

2. Start the Word program.

3. Close all open documents.

4. Place the Software floppy in the A: or B: floppy drive.

5. Using the File/Open menu option, open the SETUPWDB.DOC from the floppy.  You may 
have to change the drive in the File Open dialog box to be able to open the 
SETUPWDB.DOC.  Refer to your Word User's Manual for more information on opening 
files located on a floppy disk.

6. On the first dialog box fill in the required information.  
1) Type in the name of the floppy drive that you are installing from, ending with a "\".  
2) Enter the drive and path of where you want the database file to be copied to, ending 

with a "\".  
3) Enter the drive and path of the NORMAL.DOT file, ending with a "\".

7. If you do not know the requested information then exit the installation by clicking the Cancel
Installation button.  Otherwise click the Continue Installation button to go on.

8. Two message will notify you that the DATABASE.WDB and LETTERWD.DOT files are 
about to be copied.  If the installation process finds files with the same names, it will notify 
you and you will have the opportunity to Cancel the copy action or to confirm it.

9. After a few seconds you will be notified that the installation was successful.  If you receive 
any other messages then review the following sections: Prerequisites, Warnings, and 
Troubleshooting.



8. Exit the Word program and if asked the following questions answer Yes to both:

 

9. You  can now restart Word and use the Word Database by selecting the 
Tools/Word Database menu options.





Using the Database

If you intend to insert an address from the database into your current document, make sure that 
your cursor is located where you want the address to be inserted at.

Select the Tools/Word Database menu option to start the program.  The first dialog box will ask 
you for a search string, assuming that you want to find a specific record.  If you do not wish to 
search for a specific record then click the OK button to view the first record in the database.  
One occasion that you may not want to enter a search string is when you only want to add new 
records, but you have no need to insert an address into the document.

If you want to search for a specific record then type a word into the text box that will uniquely
identify the record that you are looking for.  The word that you type is called a search string.
All fields of all records will be searched for this string until it finds one or until it reaches the 
end of the database.

After the initial dialog box, the main dialog box will appear.  Depending on what search string 
you have typed into the first dialog box, the record displayed will either be the first record in the 
database or a record with a match of your search string.

Each record is composed of 16 fields.  The 16 fields and their database labels are the following:

Field Description Database Field Name

First Name of contact FirstName

Initial of contact Initial

Last Name of contact LastName

Salutation or Dear field Salutation

Title of contact Title

Honorary title like Mr. or Ms. BeforeName

Degree of contact like Ph.D. Degree

 



Company Name of contact, if any CompanyName

Address line 1 Address1

Address line 2, mainly for suite numbers Address2

City part of address City

State initials State

Zip code ZIP

Telephone number of contact Phone

Fax number of contact Fax

Notes for this contact Note

Each piece of information contained in the fields are kept separately.  None of the fields are 
required.  For example, if you do not have or want to enter a company name for a contact, you 
do not have to.

When you first start the database you will see a sample record containing Charles Kerekes.  If 
you want to delete this record, first you must add at least one other record to the database.

Adding A New Record
To add a new record you start by clicking the New button.  This action will clear the dialog box 
for you so you may enter new information, changes the New button to the Add button, and 
changes the Done button to the Cancel button.  Place the cursor in the proper field by pointing 
with your mouse to the field and clicking the left mouse button once.  You must have a flashing 
vertical cursor in a field before you can type any information.  

 



The information you are entering may be too long to fit in the text box provided.  This is not a 
problem since the field will scroll horizontally to accommodate any number of characters.  
However, it is not a good idea to enter extremely long fields since it may slow the database 
down.

To easily move from one field to another in a sequence, simply hit the Tab key on your 
keyboard after you are finished entering the current field.



Once you have entered all of the required information, you must click the Add button to 
complete adding the new record to the database.  After clicking the Add button, the new record 
is added to the beginning of the database and will become the first record.

If you do not want to add the record you have just entered then click the Cancel button.

Finding A Record

Searching for text.
To find a specific record you must provide a search string for the database to look for.  This 
search string is any word or part of a word that the record you are looking for contains.  There 
are two places that you may enter this search string: 1) When starting the database you may enter
it in the initial dialog box or 2) once you are in the database you may click the Find button.

Once you have typed in the search string, click the OK button to start the search.  The database 
will stop on the first record containing the search string.  If the record displayed is not the one 
you want, you may repeat the search to find other matching records.

For example, if you want to find the record for Charles Kerekes you may define your search 
string as "kere".  Notice that the search string doesn't have to match the contents exactly, but it 
must be contained in some part of the field.  Since no other records have the "kere" sequence of 
characters in them, the first record the database will find is that of Charles Kerekes.

Stepping through

Once you sort your database on a field (discussed later) you may be close to the record you 
want, but for some reason can't define an accurate search string.  In this case you can use the 
Next and Previous buttons to step through the database one record at a time.

Jump to First or Last record

You may have the need to quickly jump to the first or last record in the database.  One use for 
this action is to verify the sorting of the database.  Perform these actions by clicking the First or 
Last buttons.



Inserting An Address Into The Current Document
Now that you have found the record you were looking for, you can insert the address into your 
current document at the position of your cursor.  Two things you have to check before inserting 
an address: 
1) do you want a salutation inserted and 2) the formatting of the address.

If you wish the database to insert a salutation (Dear John:), you must first define a bookmark 
named "Dear" in the document into which you are inserting the address. You define bookmarks 
using the Insert/Bookmark menu options.  If you have the Dear bookmark defined and you want 
the salutation inserted, make sure that the Include Salutation checkbox in the lower left hand 
corned of the dialog box contains an X.  To toggle the X on or off simply point to it and click 
with your mouse.  If you often create correspondence with a salutation, consider creating a 
template that contains the Dear bookmark.  For more information refer to your Word User's 
Manual.  To help you get started we have included a sample letter template that has the "Dear" 
bookmark all ready defined.  To use this sample template click the File menu in Word and select
the New option.  From the list of templates shown on the dialog box choose LETTERWD.  You 
may have to use the vertical scroll bar to move the list to see this template.  Once you have a 
new document based on the sample template, place your cursor at the beginning of the line over 
the word Dear.  Now select the Tools menu and choose the Word Database option.  Find the 

record you want, make sure that the Include Salutation checkbox has an X in it and click the 
Insert button.
New document dialog box.  Shows selection of LETTERWD sample template.

To have the address format of your preference inserted, make sure that the correct option circle 
is selected at the bottom of the dialog box.  Below are the three formats of addresses using the 
same record.

Business Address format
Mr. Charles Kerekes
Info AGE Computer Services
7760 McCallum Blvd.
Suite 20205
Dallas, TX  75252

 

 
Proper cursor position before inserting address, shown in a document created using the LETTERWD sample 
template.





Attn: Format
Info AGE Computer Services
Attn: Mr. Charles Kerekes
7760 McCallum Blvd.
Suite 20205
Dallas, TX  75252

Personal Address format
Charles Kerekes
7760 McCallum Blvd.
Suite 20205
Dallas, TX  75252

When you have the desired record, you have verified the Salutation check box, and selected the 
address format, click the Insert button to place the address into your document.

Deleting A Record
To delete a record you must select it first.  In other words, the record you want to delete must
be displayed in the dialog box.  Once this condition is met, you click the Delete button.
Before deleting the record from the database, the program will warn you with a dialog box in 
which you must confirm or decline the delete action.  If you click the Yes button in the warning 
dialog box then the record will be removed from the database.  If the record you have selected 
for deletion is the only record in the database, the delete action will be canceled.  You must have
at least one record in the database at all times.

Changing The Contents Of An Existing Record
On occasion you may need to add to a record or you may need to update existing information.  
To change the contents of a record you must first find it and have it displayed in the dialog box.  
Once displayed, you simply change the desired information using your delete or backspace keys 
on your keyboard.  After typing in the new or corrected information, you must click the Update 
button to make these changes effective.  If you do not click the Update button, as soon as you 
move away from the current record your changes will be lost.

 



Sorting Records
Word Database does not sort the records automatically.  After adding new records you may
need to sort the database.  Also, if you want to change the sorting from one field to another,
you must re-sort.  Word Database allows sorting on five fields: Last Name, First Name, 
Company Name, City, State.  All sorting is done in an ascending alphanumeric order.  As an 
example, if the following five fields were contained in a database on which a Company Name 
sorting was perform, the order would be as follows:

123 Printing
Big Bend Automotive
Bob's Plumbing Supplies
Homeowners Insurance
Vegas Night Club

To start a database sort, click the Sort button on the main dialog box.  You will be presented 
with a dialog box of five sort options.  Select the field on which you want to sort by clicking in 
the circle in front of it with your mouse.  Complete your selection by clicking the OK button.

 

If at any time you receive an error message stating that the Database bookmark is no longer valid
then follow the instructions in the Troubleshooting section on recreating this bookmark.

 



Setting Default Preferences
Most likely you will find a preferred way of inserting addresses, sorting names, and including
a salutation.  Instead of having to select your preferred settings each time, Word Database
allows you to set these three options as defaults.  To access the options dialog box click the 
Options button on the main dialog box.

The options dialog box will present you with the three option categories that you may set as 
defaults.  Make your selections by pointing and clicking with your mouse.  When finished click 
the OK button.  These defaults will be kept until you change them again.  Your default settings 
are saved in your WINWORD directory in a file named WORDDB.INI.  Do not move or delete 
this file!

If you ever need to select an option that differs from your default, simply make those selections 
on the main dialog box or the sorting dialog box.

 





Mail Merging

The database file that Word Database maintains may be used to merge the information into a 
mass mailing.  The database file name is DATABASE.WDB and its located in the directory that 
you specified at installation time.  This file is opened the first time you run Word Database and 
stays open until you exit Word or until you close the file.

When merging the database file using Word's merge feature, keep in mind that the last row 
(control row) contains some control text that the merge process will include unless you define a 
merge criteria.  For more information on merging see your Word User's Manual.

It is not advised that you change any data within the database file directly.  If you want to 
manipulate the data in a way that Word Database does not allow then please keep the following 
precautions in mind:

1. Never delete the header (first row) or the last row in the database table.

2. You may change the wording in the header row, but you cannot rearrange the order of the 
columns.

3. Never delete any of the columns from the database table.

4. In the top left-hand cell of the table there is a bookmark named "TopLeft".  This bookmark 
cannot be deleted or moved for the database to function.

5. When inserting new record rows, make sure you insert it above the first record and below the
header row.

6. Never delete all of the records from the database table.  You should have at least the header 
row, one record, and the last row.

7. Do not change the contents of the last row.

8. Do not insert any additional rows after the last row.

9. In the bottom right cell of the table there is a bookmark named "LastLine".  This bookmark 
cannot be deleted or moved for the database to function.





Troubleshooting

Did not receive "Installation Successful" message
It is likely that you have received additional error messages if the installation was not successful.
Reinstall the Word Database and note any messages.  With those messages in hand, review the 
following sections: Prerequisites, Warnings, and Troubleshooting.

The installation may have failed because of the following reasons:

1. You did not give the proper path of the installation drive, location of database file, or 
location of the NORMAL.DOT template.  Verify these paths and reinstall.  Make sure that 
you end all paths in the installation dialog box with a "\".  Examples: "A:\", "C:\
WINWORD\", "F:\PROGRAMS\WINWORD\"

2. You may have an existing DATABASE.WDB file in the same directory that the installation 
routine is attempting to copy it's database file.

3. If installing to a network, you may not have the necessary rights to finish the tasks.  You 
must have read/write access to the following directories: location of WINWORD program 
files, location where database is to be copied, and the NORMAL.DOT file.  Contact you 
LAN administrator for further instructions.

4. You may not have the proper Word version.  It must be Word version 2.0.

Word Database option is not on the Tools menu.
The installation was not successful.  Review above steps and reinstall Word Database.



Cannot find the WORDDB.INI or DATABASE.WDB files
 

µ §

The DATABASE.WDB or WORDDB.INI files have been deleted, moved, or are not available.  
Any number of the following possibilities may have caused this condition:

1. The Word Database is running from a shared NORMAL.DOT template, but has not been 
installed on this computer.

2. One of the two files have been deleted.

3. The network drive mappings may have changed and no longer match the information in the 
WORDDB.INI file.

4. The DATABASE.WDB may have been moved to a different path or the file has been 
renamed, or deleted.

After receiving this error message, you will be asked to provide the exact location of the 
DATABASE.WDB file.  Make sure you end this path statement with a "\".  This action will 
recreated the WORDDB.INI file with the proper DATABASE.WDB file path.  If the error 
persists then you must verify the existence of the DATABASE.WDB file and its exact location.  
You may use the File Manager for this task.  If the DATABASE.WDB file cannot be found then
restore a backed-up version from tape or archive disks.  If no archives exist then copy the blank 
database file from the original installation disk.



This bookmark does not exist
Word Database looks for four distinct bookmarks.  Three are located in the database file and
one may be located in the document you are inserting an address into.  The four bookmarks
are explained below:

"Dear" bookmark:

If you would like word Database to insert a salutation into your document, in addition to the 
address, you must first define a bookmark named "Dear".  To create this bookmark refer to your 
Word User's Manual and use the Insert/Bookmark menu options.

If you have an X in the "Include Salutation" checkbox on the main dialog box and you do not 
have the bookmark defined, you will receive this error message.  This does not cause any 
damage.

"TopLeft" bookmark:

This bookmark, along with the "LastLine" bookmark, is the most often used bookmark by the 
database.  If this bookmark is erased or moved, it will severely affect the database's operation.  
Since the only way this bookmark may be deleted or moved is by managing the 
DATABASE.WDB file manually, there is no specific warning referring to the "TopLeft" 
bookmark.  If you suspect that this bookmark may be damaged, do the following to verify and 
recreate:

1. Open the DATABASE.WDB file and make it the active document.

2. Hit the F5 key on the keyboard and type in the word "TopLeft" (shown on the status line, 
bottom left hand corner of screen).  If you receive the same massage, "This bookmark does 
not exist", then continue with the recreation of this bookmark.  If the bookmark exists, your 
cursor will jump to that location.  If the location of this bookmark is other than the leftmost 
cell in the first row, then continue with the recreation of the bookmark.

Recreation . . .
3. Place the cursor in the leftmost cell of the first row in the database table.

4. Click the Insert menu and select the Bookmark option.

5. Type in the word "TopLeft" in the text box and hit Enter.

6. Save the database file using the File/Save menu options.

7. You now have recreated the "TopLeft" bookmark.  Go on to verify the existence of the other 

 



bookmarks.

"LastLine" bookmark:

The "LastLine" bookmark is also essential for the operation of the database.  To verify its 
existence and proper location, follow the steps below:

1. Open the DATABASE.WDB file and make it the active document (you should all ready 
have completed this step in verifying the previous bookmark).

2. Hit the F5 key on the keyboard and type in the word "LastLine" (shown on the status line, 
bottom left hand corner of screen).  If you receive the same massage, "This bookmark does 
not exist", then continue with the recreation of this bookmark.  If the bookmark exists your 
cursor will jump to that location.  If the location of this bookmark is other than the rightmost
cell in the last row, then continue with the recreation of the bookmark.

Recreation . . .
3. Place the cursor in the rightmost cell of the last row in the database table.

4. Click the Insert menu and select the Bookmark option.

5. Type in the word "LastLine" in the text box and hit Enter.

6. Save the database file using the File/Save menu options.

7. You now have recreated the "LastLine" bookmark.  Go on to verify the existence of the last 
bookmark.

"Database" bookmark:

This bookmark is used strictly for sorting the records.  It is not only important to have this 
bookmark, it is also important to have it in the right place.  Two conditions may remove this 
bookmark or place it incorrectly: 1) By deleting all of the records from the table, you also delete 
this bookmark or 2) by inserting records manually (not using the Word Database) you may 
change the placement of this bookmark.  Follow the steps below to test the existence and proper 
placement of this bookmark:

1. Open the DATABASE.WDB file and make it the active document (you should all ready 
have completed this step in verifying the previous bookmarks).

2. Hit the F5 key on the keyboard and type in the word "Database" (shown on the status line, 
bottom left hand corner of screen).  If you receive the same massage, "This bookmark does 
not exist", then continue with the recreation of this bookmark.  If the bookmark exists your 
cursor will jump to that location.  The location of the "Database" bookmark spans all of the 



record rows, excluding the header (first row) and the control line (last row).  If all of the 
record rows are not highlighted then continue with the recreation of this bookmark.

Recreation . . .
3. With your mouse pointer starting in the left margin in-line with the first record row (second 

row of table), hold down the left mouse button and drag the selection, highlight down to the 
last record row (do not include last row in table) and let go of your mouse button.  You 
should now have all of the record rows highlighted in the table.

4. Click the Insert menu and select the Bookmark option.

5. Type in the word "Database" in the text box and hit Enter.

6. Save the database file using the File/Save menu options.

7. You now have recreated the "Database" bookmark.

My screen is locked up and will not respond
Word Database freezes the screen to increase performance.  In case of improper exit or an 
unexpected error, the Word Database program may end without un-freezing the screen.  Keep in 
mind that even though the screen has been frozen, the Word program is still running and will 
respond to every keystroke or menu selection.  The following steps will help you regain control:

1. Save your current work with the File/Save All menu option.

2. Click the File menu and select the Exit option.  Your screen may still contain the remains of 
the Word window, but this should not effect anything.

3. Hit Ctrl+Esc to view the Task List and switch to the Program Manager by double clicking 
your mouse on the wording "Program Manager".  

4. Minimize the Program Manager window and maximize it again to clear any parts of the 
Word window still being displayed.

5. Restart the Word program and continue.



No more records in the database
Under normal circumstances, the Word Database will not allow you to delete the last record
from the database.  If someone deletes all records from the database file manually then the
above message will appear.  To continue you must add at least one record to the database.  
Notice that the main dialog box is in the New record mode and the Add button is visible.

You cannot exit Word Database by pressing the Cancel button since you will be in an endless 
loop.  You must enter at least a first name and press the Add button.  Do not attempt to exit this 
loop by double clicking the control box.  This action will exit the program and at the same time 
leave your Word screen frozen.  If this happens refer to the Troubleshooting section under "My 
screen is locked up and will not respond."

Program Status Report
It may be helpful in troubleshooting a problem to view the status report.  This report shows a 
dialog box containing the following information:

1. Exact version number and type of the Word Database macro program

2. The complete path where Word Database looks for the DATABASE.WDB file

3. The name of the window that you were in before running Word Database

4. The complete path of the WINWORD program files

To view this report start the Word Database by selection the Tools/Word Database menu option 
and type in the dialog box "show status" as a search string.  You must type in the two words 
exactly as shown in the previous sentence, not including the quotation marks.

 

 



If you are receiving messages that may indicate a wrong file path name, verify the actual 
location of those files and compare them with the status report.

If the DATABASE.WDB path is not correct on the status report then you will receive and error 
message and will have the opportunity to correct the path.  The path of your WINWORD 
program is automatically sensed and should always be correct.

Receiving Additional Help

If you are having problems with Word Database and after reviewing the Prerequisites, 
Troubleshooting, and Warnings sections and your Word User's Manual you do not find the 
solution then you may contact us at:

Fax: (214) 248-5847 x 400
CompuServe: 71035,405
Phone: (214) 248-5847 x 201, 8:00 a.m. to 5:00 p.m. CST, on normal business days.

Info AGE Computer Services is not strictly a software developer, but a consulting firm helping 
companies increase productivity with the application of computer technology.  It is possible that 
when you call for help on this program, we will be out helping clients.  We do, however, 
appreciate your business and have every intention on providing support to those with questions 
or problems.  

It may be better for you to fax or send a message through CompuServe to receive technical 
assistance on Word Database.  When sending a message, please give as much detail of the 
problem as possible.  Also provide us with a number of ways to reach you, for example: phone 
number, fax number, mailing address, and of course your full name.





Registering Word Database

If you received this software as a shareware product or if you would like to purchase additional 
licenses then please fill in the form and send your check to the address shown.

Name:
Company:
Mailing Address:
City, State, Zip:
Phone (optional):
Fax (optional):
Circle Media Desired: 5.25" disk 3.5" disk

Item Price Qty. Extended

Word Database in quantities of 1 through 5 (each) $19.95

Word Database in quantities of 6 through 20 (each) $16.95

Shipping and handling of first product (first) $2.75 1

Shipping and handling of additional products (each) $.50

Sub Total

Add 8.25% sales tax in Texas

Total Enclosed

Comments or special instructions:



Please make check payable to Info AGE Computer Services and mail to:

Info AGE Computer Services
7760 McCallum Blvd.  #20205
Dallas, TX  75252





If Not Completely Satisfied

If, for any reason, you are not completely satisfied with your registered version of 
Word Database, follow the steps below within the first 30 days of purchase to receive a refund:

1. Write a short note explaining your dissatisfaction with the product.

2. Include your full name and address on the note.

3. Send a copy of the original invoice, your note, the original software diskette, and all 
accompanying materials, no later than 30 days after purchasing the software, to:

Info AGE Computer Services
7760 McCallum Blvd.  #20205
Dallas, TX  75252

4. Discontinue using the Word Database.

Upon receipt of the items outlined above, a refund check in the total amount of the products 
returned and any sales tax paid will be immediately issued and sent to you.  Handling fees are 
not refundable.

Your honest constructive criticisms and comments will be greatly appreciated.
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